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Introduction to the 
CS450000 EEPROM 

he CS450000 is a 4 Kbit serial Electrically Erasable PROM. The memory is 
accessed via a simple Serial Peripheral Interface™ (SPI™) compatible serial 
bus. The bus signals required are a clock input (SCK) plus separate data in (SI) 
and data out (SO) lines. Access to the device is controlled through a Chip 

Select (CS) input. Also, write operations to the device can be disabled via the write-
protect pin (WP). 

SPI is a trademark of Motorola Corporation. 

Registering Your C Stamp or C Stamp Related 
Product 
At A-WIT Technologies we respect your privacy; however, we do ask you to register 
your C Stamp or C Stamp related product, so you can receive free of charge product 
updates. The registration procedure is simple. Just send an e-mail to tech_support@a-
wit.com with the word “REGISTRATION x” in the subject line, where “x” is the 
product number that you purchased. If you purchased more than one product, send an 
e-mail for each different product. 

Introduction to the CS450000 EEPROM 
The CS450000 is a 4 Kbit Serial Electrically Erasable PROM in an 8-pin DIP form 
factor package that can be used in breadboards or printed circuit boards. Write 
operations to the device can be disabled via the write-protect feature. The EEPROM is 
compatible with the C Stamp microcomputer’s supplies and signal levels. Reading and 
writing from the memory is made easy with A-WIT's supplied software commands 
EXREAD and EXWRITE. These simple two commands interface is all that is 
required to communicate with the EEPROM. 
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Technical Specifications 
Low-power CMOS technology 

Write current: 3 mA typical 

Read current: 500 μA typical 

Standby current: 500 nA typical 

Write cycle time: 5 ms max. 

Built-in write protection 

Power on/off data protection circuitry 

Block write protection 

Protect none, 1/4, 1/2 or all of array 

Sequential read 

High reliability 

Endurance: 1M cycles 

Data retention: > 200 years 

ESD protection: > 4000V 

8-pin PDIP 

Temperature range supported: -40°C to +85°C 

Flexible 1.8 - 5.5 V power supply requirement 

Max clock frequency: 1 MHz 

Compact and breadboard friendly 

Compatible with C Stamp microcomputer 

Detailed Pin Description 
The figure below shows the pins arrangement of the CS450000, and the following 
table shown the Detailed Pin Description. 
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EEPROM Pin-Out Connectivity 

Pin Name Description 

1 CSn Chip Select Input. 

Connect to any non dedicated I/O pin, except the SPI related 
pins (pins 28, 29, and 30). 

2 SO Serial Data Output. 

Connect to C Stamp pin 29. 

3 WPn Write-Protect Pin. 

Connect to any non dedicated I/O pin, except the SPI related 
pins (pins 28, 29, and 30), or connect to Ground through a low 
value resistor (e.g. 287 Ω) to permanently write-protect the 
chip, or connect to the Power Supply through a low value 
resistor (e.g. 287 Ω) to permanently not write-protect the chip. 

4 VSS Ground. 

5 SI Serial Data Input. 
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EEPROM Pin-Out Connectivity 

Pin Name Description 

Connect to C Stamp pin 30. 

6 SCK Serial Clock Input. 

Connect to C Stamp pin 28. 

7 HOLDn Hold Input. 

Connect to the Power Supply through a low value resistor (e.g. 
287 Ω). 

8 VCC Supply Voltage. (1.8 V to 5.5 V) 
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Getting Started 
his chapter is a quick start guide to using the CS450000 EEPROM with the C 
Stamp. This assumes you have a C Stamp and an appropriate connection kit 
or development board with the RESET and START circuitry, and the 
EEPROM properly connected to the C Stamp. You will also need a 

programming cable, power supply, PC running Windows® 2000/XP/Media, with a 
quantity of RAM recommended for the OS, sufficient free hard disk drive space for 
the software installations, CD-ROM drive, Internet access (recommended only), and 
available port compatible with your programming cable. 

Notices 
CSTAMP™ and CSTAMP™ Related Hardware Products, Software 
Products and Documentation are developed and distributed by A-WIT 
Technologies, Inc. All rights reserved by A-WIT Technologies, Inc. A-WIT 
SOFTWARE OR FIRMWARE AND LITERATURE IS PROVIDED 
“AS IS,” WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL A-WIT BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY ARISING OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR FIRMWARE OR THE USE OF 
OTHER DEALINGS IN THE SOFTWARE OR FIRMWARE. 

MPLAB C-18 and MPLAB C-18 Users Guide is reproduced and 
distributed by A-WIT Technologies, Inc. under license from Microchip 
Technology Inc. All rights reserved by Microchip Technology Inc. 
MICROCHIP SOFTWARE OR FIRMWARE AND LITERATURE IS 
PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL MICROCHIP BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY ARISING OUT OF OR IN 
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CONNECTION WITH THE SOFTWARE OR FIRMWARE OR THE 
USE OF OTHER DEALINGS IN THE SOFTWARE OR 
FIRMWARE. 

SPI is a trademark of Motorola Corporation. 

Getting Support 
If possible, please check the C Stamp website www.c-stamp.com under SUPPORT for 
any updates to documentation, changes, or notices that may have become available 
since your Installation CD was produced. If you continue to have any issues for which 
a solution is not found in the aforementioned website, please e-mail tech_support@a-
wit.com for help. 

Installing the Microchip MPLAB and C Compiler 
Software 
The first step is to install the Microchip MPLAB software that you will use to develop 
your programs. 

Insert your A-WIT provided Installation CD in your CD drive. Go to the MPLAB 
directory in the CD and double click on the “MPLAB vX.XX Install” file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

After the MPLAB installation is complete, switch to the C18 directory in the CD, and 
double click on the file in that directory. Follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. The only 
exceptions to accepting all the default options is that on the 5th and 6th windows of the 
installation process for the C18 Compiler, you have to select everything as shown in 
the figures below. This will ensure that MPLAB is configured to use the C18 Compiler. 
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Installing the A-WIT C Stamp Quick Programmer 
To install the A-WIT C Stamp Quick Programmer, switch to the CSTAMPQP 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Installing the USB Software 
If you purchased a product with a USB download cable, make sure that the A-WIT 
provided CD is in the CD drive of your PC and insert the USB cable in the USB port 
of your PC. Windows auto detects the new USB device. If Windows prompts you to 
install drivers for the USB cable device, follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. 

After the USB adapter has been installed, open a Windows Explorer window from the 
Accessories sub-menu in the Start menu, and right click on My Computer. Proceed to 
select Properties, and then select the Hardware tab. Click on the Device Manger 
button, and expand the Ports (COM & LPT) branch. Make a note of the COM port 
that has been assigned to the USB-to-Serial adapter. This is the port that should be 
selected in the C Stamp programmer software. 

Setting Up the C Stamp Software Templates 
To set up the C Stamp Software Templates, switch to the CSTAMP_Template 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Documentation 
Copy the DOCS directory from the C Stamp Installation CD to your C:\A-WIT 
directory. This directory contains all the C Stamp related documentation in PDF 
format. 
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Creating your EEPROM C Stamp Program 
Create a directory where you want to have all the files for your program; for example 
EEPROM_APP. We recommend making this directory under your C:\A-WIT 
directory, so you can have all your CSTAMP related files in one place. 

Copy the all files in your C Stamp Software Templates directory C:\A-
WIT\CSTAMP_Template to the directory you just made. 

Open the Microchip MPLAB IDE application. As shown the following figure, the 
IDE has several sub-windows. Depending on the resolution of your screen, your sub-
windows may have a different layout. However; you can move and resize these into the 
position that you want to fit your screen, and your layout for that particular project will 
get saved upon answering yes to the prompt of saving the workspace when you exit 
the software development environment. 

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

 

 

Go to the “File” menu to “Open Workspace…”. Then navigate to your program 
directory, and open CSTAMP_Template.mcw. 

Right click on CSTAMP_Template.mcp in the “Project” sub-window, and “Save 
as…” the name of your program project after you have navigated to your program 



A - W I T  T E C H N O L O G I E S  I N C .  

 10 

directory. For example, your program project could be named “EEPROM_APP”. 
Now when you open the Microchip MPLAB IDE (Integrated Development 
Environment), and go to your program directory to open the workspace for your 
program, you will see a .mws file with the name of your program preceding it. This is 
the file that you should open any time you want to work on your program. 

Double click on the main.c source and type the following code fragment where it is 
indicated. You can omit the comments for brevity, as they are written here to offer 
clarifications of what the code does. Do pay attention; however, to the indentation of 
the code blocks between curly brackets for loops, if statements, etc. Although 
indenting the code is not a requirement for the compiler to parse your code (i.e. any 
blank spaces are ignored by the compiler), it does help tremendously to make your 
code much more readable, and consequently, it makes finding any errors easier. 
Keywords and function names in the code fragment below are bolded. 

After you START the C Stamp in user mode as explained in the “Downloading and 
Running Your Program” section (this will not be the RESET/BOOT/DOWNLOAD 
mode), the program will run. This program assumes that your EEPROM is properly 
connected to the C Stamp, that it is selected via Pin 8, and that an LED is connected to 
the C Stamp at pin 46 with a 287 Ω resistor as shown in the figure below. If you are 
using the CS310X00 BOL, then this is available in the board already. 

 

 

The program will write a 1 to location 0x000, then it will read it back, and if the reading 
of the value is successful, it will light the LED connected to C Stamp 46. Then the 
program will stop execution until you restart it by pushing and releasing the RESET 
button while holding the START button and then letting go of the latter. 

// initialize variable value 
  BYTE value = 0; 
 
// make sure pin 46 is low at the beginning 
  STPIND(46, LOW); 
 
// write 1 to address 0 
  EXWRITE_CS450000(0, 1, 8); 



A - W I T  T E C H N O L O G I E S  I N C .  

 11 

// read the value at location 0 
  value = EXREAD_CS450000(0, 8); 
// if value is not zero, turn LED at pin 46 on 
  if(value) STPIND(46, HIGH); 
// stop 
  STOP(); 

Save your program from the “File” menu or by clicking on the appropriate icon in the 
tool bar. Then “Build All” from the “Project” menu or from the tool bar. 

If the code was typed correctly, you will have a file in your program directory with the 
name of your program project and a .HEX extension. An example is 
EEPROM_APP.HEX. This is the file that you will download to the C Stamp, as 
explained up ahead. 

If you get an error message or an indication that your program did not build 
successfully in the “Output” sub-window of the IDE, you probably have one or more 
syntax error(s). Double click on the line of the “Output” sub-window that mentions 
the error, and the program line that most likely contains the error will be indicated in 
the sub-window where you were editing your program. Correct as necessary, and 
“Build All” again until you get a successful .HEX file output. 
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Downloading and Running Your Program 
Power up your KIT, and connect the KIT to the PC with the provided cable. Upon 
power up, the C Stamp will be in RESET/BOOT/DOWNLOAD mode. To go back 
to this mode at any time, just push and let go of the RESET button. Then open the A-
WIT C Stamp Quick Programmer application shown in the next figure. 

 

 

The first step is to choose the serial port that you are using from the drop-down menu. 
Then click on “Refresh”, so that the program registers your selection. Your selection 
should show in the status area of the program next to “PORT:”. Then click on “Open 
HEX File” and load/select the HEX file that you had previously created during the 
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development of your program. The status are should indicate that the file has been 
loaded successfully. This is what will be downloaded to the C Stamp. Then click on 
“Connect”, and the PC will be connected to the KIT, and the status area should 
indicate so. To download the HEX file to the C Stamp, just click on “Write Device”, 
and you should see the progress bar after a few seconds, as the HEX file is 
downloaded. At this point, you can click on “Disconnect” to disconnect the PC from 
the KIT, disconnect the serial cable from both the PC and the KIT, and start your 
program manually at the KIT. To do this just push and let go of the RESET button 
while pushing the START button. Then you can let go of the START button. 
Alternatively, you can click on “Normal Mode” to start your program from the PC. 
This will also disconnect the program/PC from the KIT. Then you can disconnect the 
serial cable from the PC and the KIT. You can also instruct the CSTAMP™ Quick 
Programmer to wait several seconds before starting your program from the PC and 
disconnecting by adjusting the “SECONDS TO START” slide. This feature is useful 
in case you want to keep the PC connected with the serial cable, but need time to 
manually set up something in a circuit that you have built. If this is not the case it can 
just be left at the default of “0”, and your program will started from the PC right away. 
After you click “Normal Mode” and your program is started, the CSTAMP™ Quick 
Programmer will not be communicating with the C Stamp any longer, so if you want 
to reconnect, you must click on “Connect” again. 
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Accessory Specific 
Functions and Commands 
Reference 

his chapter describes the functions and commands that are specific to the 
software support of different types of accessories that are available from A-
WIT Technologies to complement the function and projects developed with 
the C Stamp. The user should consult the manual for a specific accessory for 

full information on connectivity and usage. 

EXREAD_CS450000 
BYTE EXREAD_CS450000(WORD location, BYTE CSn); 

The EXREAD function reads the value at location in the CS450000 EEPROM 
and returns the result. 

location is a variable/constant/expression that specifies the CS450000 EEPROM 
address to read from. 

CSn is a variable/constant/expression that specifies the pin on the C Stamp that pin 1 
(chip select) on the CS450000 EEPROM is connected to. 

The user must ensure that the location value is within the bounds of the 
CS450000 EEPROM address space and that the chip is selected. 

EXWRITE_CS450000 
BIT EXWRITE_CS450000(WORD location, BYTE value, 
                     BYTE CSn); 

The EXWRITE function writes value into location in the CS450000 EEPROM 
using CSn as the C Stamp pin connected to the CSn pin of the EEPROM. 

Chapter 
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The user must ensure that the location value is within the bounds of the 
CS450000 EEPROM address space, and that the chip is selected and not write 
protected. If successful, the function returns TRUE; otherwise it returns FALSE. 
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Terms & Conditions 
Quality Assurance 

A-WIT has stringent quality control procedures in place to insure the best quality 
products. 

90-Day Limited Warranty 

A-WIT Technologies, Inc warrants its products against defects in materials and 
workmanship for a period of 90 days. If you discover a defect, A-WIT Technologies, 
Inc. will, at its option, repair, replace, or refund the purchase price. After 90 days, 
products can still be sent in for repair or replacement, but there will be a $10.00USD 
minimum inspection/labor/repair fee (not including return shipping and handling 
charges). 

14-Day Money-Back Guarantee 

If, within 14 days of having received your product, you find that it does not suit your 
needs, you may return it for a refund. A-WIT will refund the purchase price of the 
product in the form of a check, excluding shipping/handling costs, once the product is 
received. This refund does not apply if the product has been altered or damaged. If you 
decide to return the products after the 14-day evaluation period, a 20% restocking fee 
will be charged against a credit. 

Disclaimer 

Warranty does not apply if the product has been altered, modified, or damaged. A-
WIT makes no other warranty of any kind, expressed or implied, including any 
warranty of merchantability, fitness of the product for any particular purpose even if 
that purpose is known to A-WIT, or any warranty relating to patents, trademarks, 
copyrights or other intellectual property. A-WIT shall not be liable for any injury, loss, 
damage, or loss of profits resulting from the handling or use of the product shipped.  

How to Return a Product 

When returning, you must first e-mail sales@a-wit.com for a Return Merchandise 
Authorization number. No packages will be accepted without the RMA number clearly 
marked on the outside of the package. After inspecting and testing, we will return your 
product, or its replacement using the same shipping method used to ship the product 
to A-WIT within 30 days. In your package, please include a daytime telephone number 
and a brief explanation of the problem. 

Please contact our Sales Department at sales@a-wit.com if you have any questions 
regarding our warranty policy or if you are requesting an RMA number. 
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